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The BBC Motion Gallery Short Programmes Catalogue offers all you will need to plug that gap in
the schedule, help drive traffic to a website, provide stimulating viewing for audiences in the air or
on the ground and deliver exciting footage for mobile phones.

The majority of our Short Programme episodes are 3 or 5 minutes in duration and are therefore
ideal for any video content platform as viewers can watch on their TV, online, on IPTV or even
on digital screens whilst waiting for a haircut or for a train!

You can also visit bbcmotiongallery.com to view clips from the BBC archive – the largest
wholly owned library in the world. Here you will also find footage from other leading global
collections such as CBS News (USA), ABC (Australia), CCTV (China) and NHK (Japan).

BBC Motion Gallery – let us help you develop your creative ideas, expand your customer base
and reach a wider audience. .



NARRATED

06 999
07 Against all Odds
08 Air Show
09 Ancient Lives
10 Animal Antics
11 Animals are Amazing
12 Animal Capers
13 Animal Odysseys
14 Animal Rites
15 Animal Warriors
16 Around the World
18 Bodyscapes
20 Changing World
21 Christmas Crackers
25 Cocktails
27 Creature Features
28 Culture Fix
29 Days that shook the world:

into the 21st century
31 Did You Know...?
32 Earthly Treasures
34 First Steps
35 First Steps II
36 Flower Power
37 Global Warning
38 Great British Eccentrics
39 In from the Wild
41 It’ll Never Work: Chindogu
42 It’ll Never Work: Items
44 Living Colour
46 Magic of Making
47 Meteorite Survivors
48 Miss-Takes
49 Musical Maniacs
50 Natural Remedies
53 Peculiar People
54 Planet Wild
55 Radical Highs
56 Rewind
57 Ridiculous Records 1
58 Ridiculous Records 2

59 Ridiculous Records 3
60 Royal Portraits
61 Science of Food
63 Sporting Bloopers
64 Stingers
66 Style Trek
67 Tea Breaks
72 Weird Science
73 Wild Ideas
75 Wild Worlds
76 Wildvision
77 Witness, The
78 Wizard’s guide to Wildlife
79 Workshop Wonders
80 World’s Best 1
81 World’s Best 2
82 World’s Best 3
83 World’s Wonders
84 Zodiac
85 Zoom
86 Zoophobia

MUSIC BASED

17 Blue Skies
19 Car Stereo
22 Classic Animal Tracks 1
23 Classic Animal Tracks 2
24 Classical Inspirations
26 Connection, The
30 Destinations
33 Escape To...
43 Last Chance To See...?
45 Living Year, The
51 Natural Trax
52 New Diversions
62 Sites and Sounds
69 Ultramarine
70 Urban Freestyler
71 Urban Freestyler Extreme
74 Wild Romance

CHILDREN’S

06 999
07 Against all Odds
10 Animal Antics
27 Creature Features
31 Did You Know...?
34 First Steps
35 First Steps II
39 In from the Wild
41 It’ll Never Work: Chindogu
42 It’ll Never Work: Items
46 Magic of Making, The
48 Miss-Takes
49 Musical Maniacs
54 Planet Wild
56 Rewind
57 Ridiculous Records 1
58 Ridiculous Records 2
59 Ridiculous Records 3
60 Royal Portraits
64 Stingers
65 Stitch Up!
70 Urban Freestyler
71 Urban Freestyler Extreme
72 Weird Science
73 Wild Ideas
76 Wildvision
77 Witness, The
78 Wizard’s Guide To Wildlife
80 World’s Best 1
81 World’s Best 2
82 World’s Best 3
85 Zoom

HISTORY & CULTURE

09 Ancient Lives
14 Animal Rites
16 Around the World
21 Christmas Crackers
24 Classical Inspirations
28 Culture Fix
29 Days that shook the world:

into the 21st century
33 Escape To...
34 First Steps
35 First Steps II
50 Natural Remedies
56 Rewind
60 Royal Portraits
62 Sites and Sounds
66 Style Trek
67 Tea Breaks
77 Witness, The
80 World’s Best 1
81 World’s Best 2
82 World’s Best 3
83 World’s Wonders
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LIFESTYLE

06 999
08 Air Show
16 Around the World
19 Car Stereo
21 Christmas Crackers
25 Cocktails
28 Culture Fix
30 Destinations
33 Escape To...
38 Great British Eccentrics
41 It’ll Never Work: Chindogu
42 It’ll Never Work: Items
50 Natural Remedies
52 New Diversions
55 Radical Highs
61 Science of Food
66 Style Trek
67 Tea Breaks
70 Urban Freestyler
71 Urban Freestyler Extreme
72 Weird Science
79 Workshop Wonders
80 World’s Best 1
81 World’s Best 2
82 World’s Best 3
83 World’s Wonders
84 Zodiac

LIGHT ENTERTAINMENT

12 Animal Capers
25 Cocktails
38 Great British Eccentrics
48 Miss-Takes
49 Musical Maniacs
53 Peculiar People
55 Radical Highs
57 Ridiculous Records 1
58 Ridiculous Records 2
59 Ridiculous Records 3
61 Science of Food
63 Sporting Bloopers
65 Stitch Up!
70 Urban Freestyler
71 Urban Freestyler Extreme
72 Weird Science
74 Wild Romance
84 Zodiac

SCIENCE & TECHNOLOGY

08 Air Show
18 Bodyscapes
20 Changing World
28 Culture Fix
31 Did You Know...?
32 Earthly Treasures
37 Global Warning
41 It’ll Never Work: Chindogu
42 It’ll Never Work: Items
46 Magic of Making
47 Meteorite Survivors
50 Natural Remedies
61 Science of Food
72 Weird Science
73 Wild Ideas
85 Zoom

WILDLIFE & NATURAL

HISTORY

10 Animal Antics
11 Animals are Amazing
12 Animal Capers
13 Animal Odysseys
14 Animal Rites
15 Animal Warriors
17 Blue Skies
20 Changing World
22 Classic Animal Tracks 1
23 Classic Animal Tracks 2
26 Connection, The
27 Creature Features
31 Did You Know...?
32 Earthly Treasures
34 First Steps
35 First Steps II
36 Flower Power
37 Global Warning
39 In From The Wild
43 Last Chance to See...?
44 Living Colour
45 Living Year, The
47 Meteorite Survivors
50 Natural Remedies
51 Natural Trax
54 Planet Wild
64 Stingers
69 Ultramarine
74 Wild Romance
75 Wild Worlds
76 Wildvision
78 Wizards guide to Wildlife
80 World’s Best 1
81 World’s Best 2
82 World’s Best 3
85 Zoom
86 Zoophobia

bbcmotiongallery.com
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Genres

NARRATED CHILDREN’S LIFESTYLE

21 x 8-12 minute items 
and I x 30 minute extended item
available as two parts

The BBC’s long established prime-time series
features both actuality and re-constructions of
real life emergency situations and rescues.

Taking its title from the UK emergency services phone hotline,
999 features a wide variety of rescue incidents – often
painstakingly re-constructed – involving professional
emergency workers, people at work, outdoor enthusiasts,
action adventurers and hapless members of the public alike.
Emergencies don’t discriminate. This compilation features 22
astonishing life-threatening emergency situations, which often
call for hazardous and dangerous rescue operations. Most of
the stories are re-constructions, but they chillingly convey the
horror and reality of each incident. We are pleased to say that
in all the cases in this compilation there was a safe ending for
all involved. But each story is, nonetheless, a gripping and
sometimes terrifying excursion into an emergency nightmare.

Running order...

Bale > Barnstormer > Cement > Escalator >
Newquay Cliff Rescue > Nightclub Bouncer >
Diver > Scorpion > Paraglider > Submerged Car >
Football Lightning > Wet Leaves > Bikefork >
High Heels > Nightfall > Morris Minor > Pete Goss
> Adrift >Water Filter > Long Crawl >
Pub Surgery > Lift Shaft

999 EMERGENCY
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Genres

NARRATED CHILDREN’S

Examples...

Series I: Jake Storey (aged 5) > lain Kennedy
(aged 14) > Luke Evans (aged 9) > Craig Brough
(aged 16) > Jade Friel (aged I2)

Series 2: Tree Swing Fall > Playground Rescue >
Electrocuted! > Road Accident Hero > Glass Door
Horror > Ben Nevis Rescue

BBC Television’s Against All Odds explores the real
life dramas and crises that children often find
themselves in, and get themselves and others out
of, every year.

The stories in these packages are taken from the popular
BBC TV series of the same name and feature acts of bravery,
courage and initiative displayed by children in extreme
situations. All the items are based on fact and faithfully
re-construct the events as they happened. The re-enactments,
stylishly shot on a single camera, are dramatic and vivid, and
act as tributes to some very heroic children.

International versioning available.

Series I – 12 x 3-6 minutes
Series 2 – 24 x 3-7 minutes

AGAINST ALL ODDS: SERIES 01 AND 02
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Genres

NARRATED LIFESTYLE SCIENCE & TECHNOLOGY

Series I – 17 x 4-7 minutes
Series 2 – 10 x 6-8 minutes

In the UK, air shows are the highest attended
spectator events, second only to football, and
more popular than motor-sport, horse racing,
cricket, rugby and darts.

Aviation affects all our lives in one way or another – commercial,
civil, military and recreational. Air Show looks at the world of
flying from a variety of diverse standpoints, covering issues such
as safety, air traffic, pilots, aerobatics, rescue services, vintage
aircraft, and a host of aeronautical developments and innovations.

Informative, action-packed, and superbly filmed, Air Show
reflects the fast growing interest in aviation.

Running order...

Series I: Turn Round > Merlin > Gliders >
Catering > Courcheval Helicopters > Courcheval
Altiport > Ferry Pilots > Rarotonga > Frecce
Tricolori > Spruce Creek > Cattle Muster > Oil Rig
> Grand Canyon > Fans > Aerobatics > M.A.F >
Venoms & Vampires

Series 2: First Class Refuelling > HMS Illustrious
(Joint Force Harrier) > Regional Jets > Vintage
Aircraft at Thruxton Airshow > Glacier Flying >
British Airways Operations (BASIS) > Sea Planes,
Sydney Harbour > Mountain Flying, New Zealand >
Shanghai Airport

AIRSHOW: SERIES 01 AND 02
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Genres

NARRATED HISTORY & CULTURE

Running order...

Mongols > Nubans > Aborigine > Saami > Papuans
> Maori > Kalahari Bushman > Bhutanese >
Waorani > Masai > Marsh Arabs > Aka

Using archive footage from some of the most
remote and beautiful parts of the world, this
fascinating series looks at the history behind some
of the oldest living cultures on the planet.

Ancient Lives tells the stories of early human arrival and
settlement in some of the harshest environments on earth,
and it looks at these ancient peoples’ chances of survival for a
further thousand years...

12 x 5 minutes

ANCIENT LIVES
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Genres

NARRATED CHILDREN’S WILDLIFE & NATURAL HISTORY

7 x 60 minute series Compilations of the craziest, funniest, strangest
and most intelligent animals in the world.

A charming collection of items featuring animals who don’t
quite behave as nature intended! In the most recent addition
to the series, Animal Antics 7, you’ll meet some of the most
talented pets alive: Partex, the Jack Russell who can windsurf
and waterski; Nellie, the intelligent pig who can spell and
skateboard; Katie, the Tinseltown tiger who chills out by her
pool between movie rehearsals; and Panadero, the Spanish
stallion with an unbridled passion for soccer, plus many more
crazy capers! This action-packed series of Animal Antics will
entertain, amuse and amaze you.

Animal Antics... strangely funny, but true!

Examples...

Soda Siphon Dogs > Skateboard Pulling Dogs >
Tree Climbing Dog > Building Dog > Pub Dog >
Animals TV > Poodle Circus > Pet Pig > Counting
Horse > Window Cleaning Dog > Car Driving Dog
> Show Jumping Rabbits > Somersaulting Dog >
Skateboarding Duck > Jumping Cat > Darts Playing
Budgie > Basil, Talking Parrot Of The Year >
Twinkle, Show Jumping Rabbit > Badger, The Perfect
Dog Barman > Mister T, The Beer Drinking Horse
> Sweetheart, The Beer Drinking Eagle > George,
The Household Bull > National Purring Pussy
Championships > Showjumping Menagerie > Jasper,
The Refined Parrot > Kylie, The Canoeing Dog

ANIMAL ANTICS
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Genres

NARRATED WILDLIFE & NATURAL HISTORY

Secrets Of Survival: 55 minutes 27 seconds

Living At The Edge: 48 minutes 33 seconds

Triumph Of Life: 49 minutes 57 seconds

In just three hours, Animals are Amazing travels to
the far corners of the world’s wildest places
introducing great insights into over 170 animals. 

Animals are Amazing depicts how the animal world is
extraordinary and wonderful and how each animal exhibits
astonishing adaptations to help them triumph over near
impossible conditions. Discover how animals survive extreme
habitats, such as the North American wood frog who can be
frozen solid for up to three months and still survive. Discover
how animals risk their own lives to ensure the survival of their
next generation. Discover creatures that astound us with their
skills and ingenuity.

Approx. 154 minutes

ANIMALS ARE AMAZING
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Genres

NARRATED LIGHT ENTERTAINMENT WILDLIFE & NATURAL HISTORY

12 x 5 minutes A real life natural soap opera! Using computer
animation and professional comedy scripts, these
wildlife comedy shorts bring a wide variety of
creatures to life in a unique and humorous way.

From the biggest mammals to the smallest insects, amusing
voiceovers give these animals real character. This is a series
that will appeal to both adults and children alike.

Running order...

Series 1 – On Safari: The Waterhole > Bloody
Tourists > Vegetarian Lions > Meerkat Election

Series 2 – Jungle Fever: Orangugansters >
Monkey Show Business > Jungle Olympics >
Health Farm

ANIMAL CAPERS
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Genres

NARRATED WILDLIFE & NATURAL HISTORY

Running order...

Ocean Voyagers – Humpback Whale > Long Haul
Flight – Snow Geese > An Ariel Epic – Monarch
Butterfly > Arctic Marathon – Caribou > Home Run
– Pacific Salmon > Ocean Drifters – Turtles > The
Long Return – Eels > Global Invasion – Plants >
African Trek – Wildebeest > Desert Challenge –
Rattlesnakes > Pole to Pole – Arctic Tern > Bound
for the Sun – Swallow

Epic migrations by land, sea and air. Nature’s
journeys that stretch the limit of human
imagination...

This is a series of 12 remarkable programmes which follow
the marathon travellers of the Natural Kingdom on their
incredible journeys, unravelling some of the great mysteries of
migration. Why do animals and even some plants undertake
these odysseys and how do they accomplish the extraordinary
navigational feats that are often involved?

12 x 5 minutes

ANIMAL ODYSSEYS
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Genres

NARRATED HISTORY & CULTURE WILDLIFE & NATURAL HISTORY

12 x 10 minutes A series of fascinating short programmes about
the rites and beliefs inspired by animals all over
the world.

Animals have a special place in the beliefs and customs of
peoples. Throughout the world they are revered, worshipped
and, in some cases, used as a measure of wealth. Each
mini-documentary celebrates the festivals and ceremonies
that have developed around the natural history of individual
animal species.

Each unique story unfolds from the animal’s point of view.
Written by Simon Nash, the English version is narrated by
Tom Baker.

Running order...

Ox > Eagle > Horse > Elephant > Camel > Pig >
Bird > Cat > Rat > Peacock > Snake > Monkey

ANIMAL RITES
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Genres

NARRATED WILDLIFE & NATURAL HISTORY

Running order...

Macho Males > Protection Rackets > Food Fights >
Animal Armies > Lady Killers > Playfighting > 
Wild Weapons > Arms Race > Ritual Combat >
Ambush > Winner Takes All > Chemical Weapons

From insects to mammals, life is a constant battle
to survive and reproduce.

Trained from birth and armed with a wide range of natural
weapons, the most amazing warriors of the natural world are
organised and deadly!

This colourful and exciting series combines the most
spectacular archive from the BBC’s Natural History Unit with
contemporary and distinctive graphics, alongside specially
composed music. Be prepared to enter the fascinating arena
of the wild warriors! Kill or be killed...

12 x 5 minutes

ANIMAL WARRIORS
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GENRES

NARRATED HISTORY & CULTURE LIFESTYLE

12 x 5 minutes The BBC’s expert travel cameramen travel round
the world to film the best travel and vacation
destinations.

Twelve vignettes each of five minutes provide the low-down
on some of the coolest locations, perfect for the adventurer
and armchair traveller alike.

Episodes:

Bhutan > Borneo > Botswana > British Columbia
> Chile > Eastern Australia  > Finland > Galapagos
Islands > Malaysian Islands > Oman > Rajasthan >
Shanghai

AROUND THE WORLD
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Genres

MUSIC BASED WILDLIFE & NATURAL HISTORY

Running order...

Solar Sonata > Furious Flappers > Misty Magic >
Aerial Assassins > The Big Buzz > Lofty Landscapes
> Windswept > Nightshift > Aerial Oddities >
Beyond the Blue > Flying Formations > Top Gun >
Trouble Brewing > Madame Butterfly > Close
Encounters > Savannah Skies > Rain Dance >
Ocean Air > Heavenly Bodies > Long Haul

Meet the creatures for whom the sky is home and
soar with them for an eagle’s eye view to where
these animals live the high life.

Climb into the cockpit to discover the most stunning views as
the power and beauty of the natural elements are revealed in
this series of short programmes which are certain to fuel our
fascination with flight.

20 x 3 minutes

BLUE SKIES
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Genres

NARRATED SCIENCE & TECHNOLOGY

20 x 3 minutes Exploring the surface of the human body in
microscopic detail, using imaging techniques such
as macro-motion control and S.E.M (Scanning
Electron Microscopy).

A co-production between BBC and Science Pictures whose
skill in specialist photography has already enhanced some of
the best known science and natural history programmes.
Now harnessed to produce fascinating short programmes for
Motion Gallery, this series pushes back the frontiers of
knowledge about the human body.

Running order...

Close Shave > Lash > Cold Sweat > Tongue >
Inner Sole > Fingernail > Kiss > Smile > Sting >
Second Skin > Close Contact > The Piercing Truth
> Scratch > Nerve > Hearing > Bone > Sneeze >
Eye > Voice > Muscle

BODYSCAPES
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Genres

MUSIC BASED LIFESTYLE

Running order...

Napier > Rolls Royce Silver Ghost > Model “T”
Ford > Bugatti Type 18 > Austin 7 > Volkswagen
Beetle > Jeep > Citroen 2CV > Land Rover >
Jaguar XK 120 > Morris Minor > Chevrolet
Corvette > Ford Thunderbird > Citroen Ds >
Messerschmitt Bubble Car > Fiat 500 > Mini >
Trabant > E-Type Jaguar > Mini Cooper > Ford
Cortina > AC Cobra > MGB > Porsche 911 >
Ford Mustang > Ferrari Dino > Ferrari Daytona >
VW Golf GTI > Audi Quattro

Classic cars with music, informative captions and
some fantastic footage to create a perfect filler.

It’s fast, it’s fun and it’s just a little bit quirky. The 20th century
was the era of the car, and these short programmes celebrate
the automobile – still the ultimate status symbol!

From simple vehicle to iconic roadster, this series looks at the
many shapes, makes and characters of cars that have made up
this four-wheeled family.

30 x 3-4 minutes

CAR STEREO
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Genres

NARRATED SCIENCE & TECHNOLOGY WILDLIFE & NATURAL HISTORY

12 x 5 minutes Global Warming

Global Warming is now something we cannot ignore and as a
result people all over the world are thinking more about the
environment around them and asking questions. So how
much do we really know about the many changes, systems
and processes of our host planet? In what ways is the Earth
really changing and how much of what we are experiencing is
just part of the planet’s natural rhythms? Are there lessons
from the past to be learned? What is likely to happen to us and
is there anything we can do about it? This series of twelve, five
minute short programmes looks at how changes in our world,
although profound in their impact, are not necessarily new,
and aims to provide the answers to some of those questions. 

Running order...

Air to Breathe > Here comes the Sun  > Wild
Weather > Cold as Ice > Water of life > Changing
Landscape > Earthquake > Volcano > Ancients
Apocalypse > Living World > Humanity > Solutions

CHANGING WORLD
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Genres

NARRATED HISTORY & CULTURE LIFESTYLE

Running order...

Santa Claus > Christmas Animals > Festive Food >
Christmas Climate > Christmas Past > Green
Christmas > Surviving Christmas > Nativity Tales >
Global Christmas > A Time For Giving >
Commercial Christmas > Making Merry

Christmas Crackers takes an international view on
the Christmas theme, from toys to trees, from
reindeer to robins, from Santa to sleigh bells.

Each programme opens with a stylish title sequence featuring a
beautiful giftwrapped antique box which, as it opens, evokes
the magic of the Christmas mood, in preparation for the
treasures to be revealed within.

This is a colourful, contemporary and distinctive series of short
programmes which use a mix of footage, graphics, narration
and music to bring to life a celebration of the many themes of
Christmas from around the world.

12 x 5 minutes

CHRISTMAS CRACKERS
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Genres

MUSIC BASED WILDLIFE & NATURAL HISTORY

30 x 2-3 minutes This extremely popular and award-winning
series combines beautiful images with thoughtful
captions.

Superb wildlife images and some of the world’s favourite
music tracks have been brought together to create this
fantastic series of short programmes, which illustrate the lives
of a variety of different animals, birds and insects.

Each item is edited to a popular music track to create the
perfect entertainment programme, using only the finest
footage from the BBC Natural History Library.

Running order...

Emperor Penguin > Blue Wildebeest > Muce Swan
> Dolphin > Alligator > Meerkat > Tiger >
Hummingbird >Wandering Albatross > Army Ant
> Chimpanzee > Red Kangaroo > African Elephant
> Grey Squirrel > Hippo > Frog and Toad >
Common Vampire Bat > Elephant Seal > Giraffe >
Barn Owl > Hare > Macaw > Flamingo > Killer
Whale > Polar Bear > The Lion > Sea Otter >
Coral > Vulture > Red Deer

CLASSIC ANIMAL TRACKS: SERIES 01
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Genres

MUSIC BASED WILDLIFE & NATURAL HISTORY

Running order...

Golden Eagle > Prairie Dog > Orang Utang >
Shark > Swallow > Japanese Crane > Warthog >
Gelada > Humpback Whale > Peacock > Cheetah
> Brown Rat > Squid & Cuttlefish > Mustang >
Red Crab > Brown Bear > Seahorse > Sea Lion >
Wild Dogs > Banded Mongoose

This second series follows the extremely popular
and award winning Classic Animal Tracks I,

combining stunning images with informative
captions.

Superb wildlife images and some of the world’s favourite music
tracks have been brought together to create this beautiful
series of short programmes illustrating the lives of a variety of
animals and birds. Each item is edited to a popular music track
to create the perfect entertainment programme, using only
the finest footage from the BBC Natural History Library.

20 x 2-3 minutes

CLASSIC ANIMAL TRACKS: SERIES 02
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Genres

MUSIC BASED HISTORY & CULTURE

12 x 5 minutes Music composers find inspiration in many different
places – from art, history, travel and often from
love. But many of the great composers were also
inspired by the natural world around them.

The series is an intoxicating blend of the most famous and
stirring classical tracks alongside some of the most spectacular
natural history footage in the BBC archives.

This visual and musical extravaganza provides a fascinating
insight into the inspiration behind some of the most famous
pieces of classical music of all time.

Running order...

Saint-Saens “Carnaval des Animaux” > Wagner
“Ride of the Valkyries” > Debussy “Suite
Bergamasque, Clair de Lune” > Mozart “Piano
concerto No. 21 in C Major” > Beethoven “Piano
sonata No. 14 in C sharp Minor Moonlight Sonata”
> Dvorak “Symphony No. 9 in E Minor”, from “The
New World” > Vivaldi “The Four Seasons, Spring”
> Strauss “The Blue Danube” > Tchaikovsky “Waltz
of Flowers”, from “The Nutcracker Suite” > Bach
“Air on a G-string” > Mussorgsky “Night on a Bare
Mountain” > Handel “Water Music”

CLASSICAL INSPIRATIONS
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Genres

NARRATED LIFESTYLE LIGHT ENTERTAINMENT

Running order...

Vesper & Americano > Mojito & Daiquiri >
Moscow Mule & White Russian > Perfect Manhattan
> Cosmopolitan > Old Fashioned > Mint Julep >
Singapore Sling > Between the Sheets > Vampiro &
Margarita > Bahama Mama > Woo Woo >
Watermelon Martini > Love in the Afternoon >
Sangria Martini > Sidecar > Eggnog > Flame of
Love > Marlene Dietrich > Russian Punch &
Champagne Cocktail

Cocktails is a series of stylish, witty and
entertaining films which mix history and anecdote
to tell the story of some of the world’s most
famous drinks.

From Ian Fleming’s James Bond and his trademark vesper
martini (shaken not stirred) to Hemingway sipping a daiquiri in
Cuba, behind every cocktail there’s a great story!

20 x 3 minutes

COCKTAILS 
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Genres

MUSIC BASED WILDLIFE & NATURAL HISTORY

20 x 2-3 minutes A musical trip around our world using a simple
word and a popular song to connect mankind with
nature in all its forms. 

This collection of 20 short programmes, combines beautiful
footage from around the world with some of the best-loved,
internationally-known classic songs, from jazz and blues to pop
and rock.

Running order...

Earth: “We Have All The Time In The World” Louis
Armstrong > Snow: “It May Be Winter Outside”
Love Unlimited > Space: “Whatever” Oasis > Air:
“Lifted” Lighthouse Family > Sea: “Underwater
Love” Smoke  City > Birth: “You’re The First, The
Last, My Everything” Barry White > Moon: “Fly Me
To The Moon” Julie London > Ice: “Amami Se Vuoi”
Marisa Fiordaliso > Night: “In The Midnight Hour”
The Commitments > Sky: “Aria From Mozart’s La
Clemenza Di Tito” Sylvia Mcnair > Sun: “To Darn
Hot” Ella Fitzgerald > Home: “Dream A Little
Dream Of Me” Mamas And Papas > River: “Where
The Lazy River Goes By” Teddy Wilson > Light: “I’m
Beginning To See The Light” Bobby Darin > Beach:
“On The Beach” Chris Rea > Fire: “Only You” The
Platters > Shade: “I Scare Myself” Thomas Dolby >
The Deep: “Sea Cruise” Frankie Ford > Rain:
“Stormy Weather” Etta James > Age: “Young Hearts
Run Free” Candi Staton

THE CONNECTION
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Genres

NARRATED CHILDREN’S WILDLIFE & NATURAL HISTORY

Running order...

Tails > Beaks > Ears > Legs > Heads > Tongue >
Skin and Fur > Eyes > Wings > Armour > Feathers
and Scales > Hands and Feet > Teeth > Noses >
Lumps and Bumps

Creature Features is fun, colourful, wacky and
informative – “Edutainment” at it’s best!

Animals have evolved some incredibly odd and silly looking
anatomical features, that come in a whole range of shapes and
sizes.Their funny noses, multiple eyes, big bottoms, extra long
necks and enormous ears may look absurd, but they fulfil
some very useful functions.

Assisted by the animated ‘Features Creature’ this series
introduces you to the creatures with the weirdest and most
unusual body parts in the Animal Kingdom.

15 x 4 minutes

CREATURE FEATURES
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Genres

NARRATED HISTORY & CULTURE LIFESTYLE SCIENCE & TECHNOLOGY

15 x 10 minutes Culture Fix is a lively and accessible series covering
fine art, literature, performance and popular
culture.

Offering potted histories of each subject and incisive
contributions from leading cultural commentators, these
entertaining and informative programmes provide viewers with
a useful introduction to a wide range of cultural disciplines.

Running order...

Existentialism > Travel Writing > Kitsch > Car
Design > War Poetry > Religious Architecture >
Post-Modernism > Carnival Culture > Science
Fiction > Street Culture > The Portrait > Digital
Art > Skyscrapers > Detective Fiction >
Minimalism

CULTURE FIX
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Genres

NARRATED HISTORY & CULTURE

Running order...

Millennium > iPod > Enron > London Bombing >
Tsunami > Tora Bora > Saddam Capture >
Hurricane Katrina > Kyoto Protocol > 9/11 >
Charles & Camilla > Super Jumbo (Airbus) > Israeli
invasion of Lebanon > Beslan school siege >
London awarded 2012 Olympics > Concorde crash
> Fall of Iraq > Death of Pope John Paul II >
Genome > Orange Revolution (Ukraine)

Following on from the hugely successful BBC
Worldwide series Days That Shook The World,
this series takes a look at key moments in the
21st century so far.

The emergence of the iPod and the horrific events of 9/11 are
covered in this informative series.

20 x 3 minutes

DAYS THAT SHOOK THE WORLD:

INTO THE 21st CENTURY
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Genres

MUSIC BASED LIFESTYLE

1 x 60 minutes Postcards from around the world! Destinations is
your first class ticket to a fantastic collection of
travel shorts featuring some of the world’s most
glamorous locations.

Cities and towns, island paradises, lakes and mountains,
popular resorts, havens of peace and tranquillity. Holidays for
the discerning and budgetconscious traveller, for the intrepid
and those in search of total rest and relaxation...

Each 5-minute “postcard” uses wonderful footage to give you
a complete picture of each destination.

Running order...

Fiji > Barbados > Australia: Orpheus Island and
Daintree River > Sailing on a Turkish gulet >
Budapest > Kenya via Mombasa > Santa Fe >
Tanzania and Zanzibar > Italian Lakes > Cyprus

DESTINATIONS
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Genres

NARRATED CHILDREN’S SCIENCE & TECHNOLOGY WILDLIFE & NATURAL HISTORY

Running order...

Expensive > Longest > Largest > First > Fastest >
Tallest > Successful > Deepest > Deadliest >
Rarest > Oldest > Smallest > Heaviest

...who made the fastest million in golfing history?
What man-made structure can be seen from
outer space?

Why did the USA spend $7.2m on an icy lump of rock?
Where can you find the mysterious giant squid? Find the
answers to these and many more questions in Did You Know...?

13 x 5 minutes

DID YOU KNOW...?
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Genres

NARRATED SCIENCE & TECHNOLOGY WILDLIFE & NATURAL HISTORY

12 x 5 minutes In this new mini-series you will explore twelve of
the Earth’s most prized treasures, from diamonds
and pearls to coal.

Throughout history minerals, gemstones and precious metals
have represented wealth and power and inspired the finest
artistic talents of the world. Here you will find the world’s
greatest treasures, discover how they changed history, and
learn about their supernatural origins and magical powers.

Earthly Treasures is set to specially composed music and
combines colour footage with black and white movie archive
and superb graphics.

Running order...

Diamonds > Pearls > Gold > Silver and Platinum >
Amber > Rubies and Sapphires > Coal and Oil >
Opals > Iron > Turquoise, Jade and Emeralds >
Copper and Tin > Water

EARTHLY TREASURES
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Genres

MUSIC BASED HISTORY & CULTURE LIFESTYLE

Running order...

Australia > India > Japan > Memphis > Egypt >
South Africa > Cuba > China > Argentina >
Scotland > Ireland > Paris > New York >
Caribbean > Brazil > Mexico > Rome > Spain >
Vienna > Thailand

Where will the next three minutes take you?

Everybody wants to get away from it all from time to time –
the desire to escape can be strong. With the best travel and
location archive footage combined with specially composed
music, be prepared to be whisked away across the world to
various destinations. The character of the places – the
romance of Paris, the hustle and bustle of New York and the
classical beauty of Rome – are conjured up by a mix of local
music, the latest editing techniques and the use of beautiful,
evocative imagery.

20 x 3 minutes

ESCAPE TO...
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Genres

NARRATED CHILDREN’S HISTORY & CULTURE WILDLIFE & NATURAL HISTORY

20 x 4 minutes or 
2 x 30 minute specials

The world is an exciting place for any youngster.
But there are pitfalls as well as thrills as they take
their First Steps.

Whether on land, above the ground or under water, those
first steps in a young animal’s life will form the basis of its
understanding of the world. Their new environment is exciting
– but perilous – and mum isn’t always nearby to give a
helping hand.

Running order...

The Elephant Family > A Balancing Act > Bringing
up Baby > One Step Ahead > A Father’s Labour >
A Leap of Faith > A Mother’s Pride > Sink or Swim
> Happy Families > Ice Babies > Ahead of the
Game > A Race against Time > A Maiden Flight >
Earning their Wings > Against the Odds > Born to
Run > Beach Babies > The Great Escape > Into the
Wilderness > Like Mother Like Daughter

FIRST STEPS
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Genres

NARRATED CHILDREN’S HISTORY & CULTURE WILDLIFE & NATURAL HISTORY

Episodes:

Terns > Bats > Chimpanzees > Polar bears >
Moles > Antelopes > African bull frogs > Foxes >
Red kangeroos > Crocodiles > Tigers >
Hedgehogs > Rhinos > Elephants > Spiders >
Albatrosses > Rabbits > Zebras > Pandas >
Dolphins

The world of the young is always full of surprises,
but in the natural world there are some really
amazing ways of producing, protecting, preparing
and launching the young out into the world.

From mammals to birds to the tiniest insects, all are different, all
have something new to experience, a new story to tell.
Linking all is the overriding power of parental instincts and
maternalism that provides touching stories from even the most
bizarre species. 

20 x 3 minutes

FIRST STEPS II
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Genres

NARRATED WILDLIFE & NATURAL HISTORY

12 x 5 minutes The spectacular and amazing world of flowers!

A series of short films celebrating the stunning and extraordinary
world of flowers. Each episode covers a different topic... the
variety of colours, cultural connections, the dangerous, the
bizarre, the beautiful and the extraordinary!

It combines specially shot sequences, with the most
spectacular and colourful archive from the BBC’s Natural
History Unit, along with complementary music.

Running order...

Scent > Medicine > Colour > History > Food >
Drug > Art > Symbol > Garden > Celebration >
Love > Extreme

FLOWER POWER
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Genres

NARRATED SCIENCE & TECHNOLOGY WILDLIFE & NATURAL HISTORY

Running order...

Cashing in on the Kangaroo > Oil and Water >
Pandora’s Bees > The Plague of Plagues > Too
Many Elephants > The Horns of a Dilemma > The
Static Nomad > Pig in Paradise > Death on the
Danube > The Weight of Whales > Malaria Bites
Back > A Snail in Hell’s Chance > The Cost of
Coffee > Fished Out > Roads to Nowhere >
Falling Forests > At Home in New Zealand >
Sentenced to Life > The Green Revolution > Water
Rations

This is a topical series which looks at some of the
ecological and environmental issues which face
the planet.

Man’s interaction with the environment has led to problems
such as pollution, rainforest destruction. desertification,
erosion and even extinction of some species.

Global Warning provides an insight into some of these
problems, and shows the way man is often outwitted by
nature in his attempt to solve them.

20 x 5 minutes

GLOBAL WARNING
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Genres

NARRATED LIFESTYLE LIGHT ENTERTAINMENT

12 x 5 minutes The term “eccentric” was coined in the late
16th century. Ever since then, Britain has been
known for its colourful and unique citizens.
Hundreds of years of democracy, freedom of
speech and a strict class system have spawned
many unusual individuals.

Great British Eccentrics is a specially shot series of short films
examining 12 of Britain’s modern day eccentrics. Their
hobbies and habits will amaze and fascinate the viewer and,
hopefully, draw the odd laugh!

Running order...

Ted Hannaford: French Knitting Champion >
Captain Beany: Self Confessed Superhero > Alan
“Nasty” Nash: Chicken Worshipper and Toe
Wrestler > Ed Prynn: Arch Druid of Cornwall >
Ann Atkin: Gnome Collector > Lyndon Yorke:
Contraption Inventor > David Morgan: Traffic Cone
Collector > Jake the Rake: Alternative Lifestyle >
Monster Raving Loony Party: Alternative Political
Party > The Burry Man: Bizarre Scottish Festival >
Arthur Reeder: Post Box Collector > John Ward:
Oddball Inventor

GREAT BRITISH ECCENTRICS
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Genres

NARRATED CHILDREN’S WILDLIFE & NATURAL HISTORY

Running order...

Dolphins > Camels > Black Kite > House Fly >
Pigs > Macaques > Ducks > Moths > Dogs >
Turkey Vultures > Asian Elephant > Termites >
Guinea Pigs > Snakes > Cats > Parrots > Rats >
Peregrine Falcon > Honey Bees > Cows

More animals than would at first be imagined
have come In From The Wild – into our towns and
even our homes.

Some animals have not altered their natural habitats, others
adapt their behaviours to a new urban niche. Man has forced
domestication, realising he can harness the instinctive
behaviours of some animals or breed new qualities into them.

In From The Wild compares animals that live in the company of
humans with their wild relatives.

20 x 5 minutes

IN FROM THE WILD
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Genres

NARRATED HISTORY & CULTURE LIFESTYLE

12 x 5 minutes Audio-visual interpretations of twelve well-known
poems.

In Motion provides a perfect introduction to a series of well-
known poems, accessible to international audiences, and with
a special emphasis on the deaf community.

In each of the films, hard of hearing actors play out a
dramatisation of a poem, integrating sign language into
rhythmical and poetic movement and dance within the
performance.

Although In Motion has been produced with hearing impaired
audiences in mind, the series aims to break down the barriers
that exist between the deaf and the hearing community, and
the programmes can be enjoyed (around the world) equally
by both audiences. 

In Motion provides a thought provoking and often moving
experience.

Running order...

“How Do I Love Thee” Elizabeth Barrett Browning
> “London 1940” by Frank Thompson > “Warning”
Jenny Joseph > “When My Love Swears” Sonnet
138, William Shakespeare > “The Road Not Taken”
Robert Frost > “May I Feel Said She” E.E.
Cummings > “Kubla Khan” Samuel Taylor Coleridge
> “Go No More A Roving” Lord Byron > “First Day
at School” Roger McGough > “Not Waving, But
Drowning” Stevie Smith > “A Woman To Her
Lover” Christiana Walsh > “Strange Meeting”
Wilfred Owen

IN MOTION
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Genres

NARRATED CHILDREN’S LIFESTYLE SCIENCE & TECHNOLOGY

Examples...

The battery-powered rotating spaghetti fork > The
‘shopping’ umbrella which can hold 5 shopping bags!
> Kenji demonstrates inventions, e.g. ladies’ travel
hat with supporting chain and suction cup to prevent
head-lolling on trains! > Portable, roll-out pedestrian
crossing > Kenji demonstrates the ‘Zoom’ fly swat!
> Chopstick glove for correct chopstick positioning!
> Kenji reveals a first look at the 2-stage umbrella
camera > Universal train grab-handle with suction
cup > Kenji demonstrates synchronised floor and
ceiling mop > Audio enhancers – bowl shaped ear
extenders > Spy Jacket – saves weight, bullet-proof
arms only so you can put your arms in the path of
speeding bullets! > Portable tube-train seat you
squeeze between other passengers.

Japanese inventor extraordinaire Kenji Kawakami
has founded Chindogu the Japanese Useless
Inventions Society.

Kenji’s philosophy for setting up the Chindogu is to keep a
steady flow of outrageous ideas so that other inventors will be
inspired to think laterally and perhaps produce ideas that will
be useful.

This brilliant compilation contains a hilarious mix of spoof
‘commercial breaks’ along with location reports of various
inventions being tested by the public.

36 x 1-2 minutes

IT’LL NEVER WORK: CHINDOGU



42

Genres

NARRATED CHILDREN’S LIFESTYLE SCIENCE & TECHNOLOGY

55 x 3.5 minutes Stories from It’ll Never Work take a lighter took at
some of the bizarre, amazing and more radical
ideas and inventions that are becoming possible in
today’s hi-tech world.

From inspired amateur inventors right through to multi-million
dollar space and aviation companies, the new ideas featured in
It’ll Never Work: Items are guaranteed to raise an eyebrow and
provide thought-provoking entertainment.

Examples...

Propeller Pack > SEGA > Folding Items > Robot
Wars > Car in a Case > Netgun > Ralph > Aaron
> Skycar > Springwalker > Magnet Grippers >
Mind Control > Scuba Dog > DCX > Air Car >
Lifeguards > Flight > Super Bike > Art of
Explosions > Pathfinder > Lawn Buddy >
Robosaurus

IT’LL NEVER WORK: ITEMS
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Genres

MUSIC BASED WILDLIFE & NATURAL HISTORY

Running order...

Common Dormouse > Orang-Utan > Great White
Shark > Sea Horse > Andean Condor >
Chameleon > American Bison > Wolf > Rhino >
Loggerhead Turtle > Tiger > Orchid > Mahogany
> Humpback Whale > Monarch Butterfly > Giant
Panda > Great Crested Newt > Spectacled Bear >
Black-Footed Ferret > Compilation

Last Chance to See...? is a poignant and timely look
at endangered species. Creatures range from the
Wolf to the Humpback Whale, and there’s a great
variety of music, from the Pet Shop Boys to Billie
Holiday.

View each animal’s plight and see man’s role in its downfall.
Some stories show a positive outcome, whereas others warn
of the impending extinction of some of nature’s most famous
and well-loved species.

Subtitles give information and facts, and the pictures and music
are tightly woven together to create this beautiful and moving
short programme series.

20 x 2-3 minutes

LAST CHANCE TO SEE...?
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Genres

NARRATED WILDLIFE & NATURAL HISTORY

12 x 5 minutes Living Colour – elegant, unique, totally engaging –
is a radically new presentation style for short
Natural History Programmes.

Living Colour combines stunning footage with eye-catching
graphics, specially composed sounds and music with a clever,
rhythmic and lyrical commentary. Living Colour brings you the
facts and mysteries behind the spectacular profusion of colours
in nature – in a completely new way.

Running order...

Red > Blue > Green > Yellow > White > Black >
Brown > Neon > Pink > Spots > Stripes >
Patterns

LIVING COLOUR
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Genres

MUSIC BASED WILDLIFE & NATURAL HISTORY

Running order...

January > February > March > April > May > June
> July > August > September > October >
November > December

Hot and Cold, Day and Night, Winter and
Summer – each month has two aspects, its
northern and its southern side.

Twelve breathtaking 5-minute films will take the audience on a
seamless journey across the world to reveal the character of
each month.

Dramatic graphics build an atmosphere of contrast and
synchronicity between the hemispheres and around the globe.
More than one ‘screen box’ runs against a black background
and each box shows action from around the world sharing the
same timeline. By zooming in and out of these boxes a
seamless journey shows the importance of each month like
never before.

Stunning time-lapse images create the illusion of perpetual
movement, transporting the audience across the planet on a
journey of discovery.

12 x 5 minutes

THE LIVING YEAR
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Genres

NARRATED CHILDREN’S SCIENCE & TECHNOLOGY

10 x 3-5 minutes What goes into the making of the things all
around us – the clothes we wear, the bread we
eat, the paper we write on?

In a series of short (3-5 minute) films, the Magic of Making
takes us behind the closed doors of industry, and combines
fascinating pictures, perfect music and a light-hearted voiceover
to make a series that captivates the younger audience and
fascinates the elder. On a delightful journey to the finished
product, each programme starts from the earliest possible
stage, such as the sheep eating grass in Woolly Jumpers and
works quickly through to the end result, such as the boy licking
his cornet in Ice Cream. There are no in-vision presenters, so
re-versioning is as easy as making the translation.

Running order...

Bottles > Scrap > Water Cleaner > Beer > Paper
> Bread > Drinking Water >Woolly Jumpers > Ice
Cream > Church Bells

MAGIC OF MAKING
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Genres

NARRATED SCIENCE & TECHNOLOGY WILDLIFE & NATURAL HISTORY

Running order...

Age of the Mammals > Invincible Insects > Powerful
Plants > Hard Cases > Air Superiority > A Winning
Smile > Able Amphibians > Jurassic Jaws > Fishy
Fortunes > Dinky Dinos > Water Garden
Wasteland > Death of the Dinosaurs

Sixty-five million years ago a gargantuan
meteorite hurtled into Mexico and created a
biological blitz. It created a holocaust for the
dinosaurs and hailed a new dawn for the little
guys. This knockout children’s series charts the
race to conquer the new world.

Landslides moved mountains, storms and tidal waves tore up
roots, fires scorched the land and then plummeting temperatures
strangled the earth in an icy grip. Over 70% of species were
wiped out and this desolate new world was up for grabs...

Each short film focuses on a group which survived and we see
how some survivors turned apocalypse into opportunity. Some
simply avoided the calamity – plants spread their seeds into
outer space. Others took advantage of the disaster – crocodiles
pre-programmed their eggs to produce an army of females.
But the most successful evolved and adapted – nocturnal
mammals braved daylight for the first time.

When the smoke cleared... the race started...

12 x 5 minutes

METEORITE SURVIVORS
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Genres

NARRATED CHILDREN’S LIGHT ENTERTAINMENT

Hundreds of clips available.
Further details available on request.

These hilarious collections of popular out-takes
and bloopers prove that if anything can go wrong,
it will!

From props that won’t work, doors that won’t open, animals
that steal the limelight – for all the wrong reasons – or actors
who just can’t get their lines right or stay on their feet, these
clips never fail to make you fall off your chair!

Examples...

Presenter drops new invention > Giggling weather
presenter > A reporter in boat collides with another
boat > Actress forgets her lines > Flatulent horse >
A car reverses into camera > Uncooperative acting
dog > Actor’s wig falls off > Cow urinates on
actor’s foot > Actor pushed over by waves >
Actress drops cigarette down her top > TV chef
puts salt in recipe instead of sugar > Cobra gets free
whilst being put into box > Tiger pushes
cameraman over > A horse mimics the presenter as
he is speaking > A dog takes a bite out of the furry
microphone > Political party sign falls off wall during
a conference > Newsreader caught drinking coffee
as she is about to go on air

MISS-TAKES
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Genres

NARRATED CHILDREN’S LIGHT ENTERTAINMENT

Running order...

Nose Pianists > Throat Player > Bicycle Pump Lady
> Four Year Old Pianist > Nose Knocker > Loo
Music > Underwater Piano > Kettle Man > Two-
Tone Whistler > Upside-down Piano > Worst Pub
Singer > Welsh Garage Band > Syringe/Bike Pump
Player > Mouth Band > Jazz Player > Central
Heating Pipe Player > Rattling Bones > Nose
Organist > Rocking Friar > Human Juke Box >
Amazing Truck > Music Man

The title of this one-hour package of ‘musical’
items says it all.

The unusual junk bizarrely used as makeshift instruments
ranges from kettles to bicycle pumps and even central heating
pipes.The eccentrics who play them are determined to outdo
each other in the sheer peculiarity of their improvisation.

1 x 60 minutes

MUSICAL MANIACS
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Genres

NARRATED HISTORY & CULTURE LIFESTYLE SCIENCE & TECHNOLOGY WILDLIFE & NATURAL HISTORY

Running order...

Body ‘Chi’ > Yoga and Meditation > Herbal
Medicine > Homeopathy > Diet > Healing
Touch > Music and Dance > Body Treats >
Healing Animals > Laughter > Environment >
Light and Colour

It is well established that stressful living leads to
ill-health, both physically and mentally. As life in
the new century is already proving to be more
stressful than the last, millions of people across
the world are turning back to nature for solutions.

With the growing popularity of alternative treatments and
therapies, Natural Remedies explores the diverse ways that
nature can heal, cure and generally improve our well being in
ways that conventional medicine does not.

Using a combination of specially shot archive and graphics,
Natural Remedies investigates the healing power of nature and
explores the background philosophies, theories and principles
behind these practices.

12 x 5 minutes

NATURAL REMEDIES
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Genres

MUSIC BASED WILDLIFE & NATURAL HISTORY

Running order... 

Marine > Ice (Tundra) > Desert > The Bush >
Mangrove Swamps > Bats (Underground Club) >
Jungle (Rainforest) > Primates > Savannah >
Northern Forests > Meadow > Freshwater

An award-winner at the International Wildlife
Film Festival for Best Music Video

A fresh idea using music sampled from live animal sounds from
around the world. A combination of unique footage, graphics
and specially composed music covering the Rainforest, Marine,
Desert and Savannah, amongst many other natural habitats...

12 x 3 minutes

NATURAL TRAX
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Genres

MUSIC BASED LIFESTYLE

54 x 2-10 minutes An exciting collection of short programmes,
edited to music to provide a unique combination
of flexibility and international audience appeal.

New Diversions features spectacular, colourful and unusual
footage, specially shot and selected from the BBC’s extensive
library. Items of various lengths are grouped in themes to offer
a wide choice of subjects. Each item is self-contained and
explained using music and pictures, and these items can easily
be scripted and voiced if desired.

Examples...

Free Falling > Stunt Flying > White Water Canoeing
> Samurai Sword Maker > Fish Flying > Chinese
Silk > Zebra > Otters > Scorpions > Butterflies >
Baboons

NEW DIVERSIONS
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Genres

NARRATED LIGHT ENTERTAINMENT

Running order...

Chariot Racing > Collection of 200 Telephones! >
Turf in a Pub > Cottingley Fairies: True? > Metal
Sculpture > Cathedral Built Single-Handedly
>World War One Recreation > Sailboard Chain
World Record > Chimney Built from Dominoes >
Pedal-Controlled Tanks > Coal Sculpture > Strange
Inventions > Pipe-Maker 80-hour Masterpiece > Mr
M-Wurzel, Licensed Eccentric > Lawn Mower
Formation Dancing > Black Pudding Eating
Championships

Just as the title suggests, this is a collection of odd
short stories showing clearly why the English
maintain their foremost reputation for eccentricity.

Peculiar People features odd, weird and wonderful people from
all walks of life, demonstrating their strange hobbies, talents
and obsessions that have to be seen to be believed!

1 x 60 minute

PECULIAR PEOPLE
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Genres

NARRATED CHILDREN’S WILDLIFE & NATURAL HISTORY

3 series of 26 x 30 minutes 
plus 12 x 5 minutes or 20 x 3 minutes

Planet Wild is a fresh, exciting look at the world 
of wildlife.

The programme can be licensed in various forms – either as
26 x 30 minutes, 12 x 5 minutes or 20 x 3 minutes. The
series celebrates the diversity, spectacle and wonder of the
natural world with each episode an exploration into a
particular animal species or an insight into an area of the globe.
With remarkable cinematography and compelling narration,
Planet Wild is one to watch.

Examples...

Secret Worlds > Reefs > Extremes > Caribbean >
Tiny Beasts > Monsters > Beaks and Teeth >
Jungles > Hibernation > Survival > Armour >
Tropical

PLANET WILD
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Genres

NARRATED LIFESTYLE LIGHT ENTERTAINMENT

Running order...

VTT Vitesse > Skeleton Bob > Kite Surfing > Ski
Boarding > MTB Trials > Acroparagliding > Wake
Boarding > Cloud Hoppers > Kayaking >
Paramotoring and Ski Biking

A highly entertaining and original adventure series
featuring some of the most unconventional and
high-risk sports in the world.

Taking advantage of the go-anywhere properties of the next
generation of modern digital cameras, Radical Highs goes in
spectacular fashion, right to the cutting edge of these new,
evolving and ‘radical’ adventure sports.

10 x 15 minutes

RADICAL HIGHS
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Genres

NARRATED CHILDREN’S HISTORY & CULTURE

101 x 90 seconds Imagine being young and caught up in one of the
momentous events in history. The experience
stays with you for a lifetime.

Rewind is an international collection of 101 true stories drawn
from around the world, turning the clocks back on the major
events of the last 100 years.

Using a backdrop of archive footage, children recall what it
was like to be there at an impressionable age, re-living or
re-telling these amazing true life stories.

Examples...

1906, San Francisco Earthquake > 1912, Titanic
Sinks > 1922, Tutankhamen Tomb Found > 1930,
1st Football World Cup > 1940, World War 2
Evacuee > 1955, Disneyland Opens > 1968, Martin
Luther King Murdered > 1975, Vietnam: The Fall of
Saigon > 1981, Prince Charles and Lady Diana’s
Wedding  > 1999, The Millennium Dome

REWIND
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Genres

NARRATED CHILDREN’S LIGHT ENTERTAINMENT

Including...

Pogo Record > Lawn Mower Boy > YoYo Champ >
Karate House >Woolsack Race > Power Granny >
Bubbles > Linford Learns to Sail >Worm Charming
> Girls’ Football > Longest Sandcastle > Toy
Balloon Jump > Timber Carnival > Watermelon
Seeds > Pedal for the Planet > Mass Surf > Banana
Museum > Superflag > Records of the Week: Food,
Tall, Wacky, Groups, Scarf, Air Dedication,
Millennium, Wakeboarding, Panto Horse Racing

Taken from the BBC series Record Breakers,
Ridiculous Records has the biggest, strongest,
fastest, craziest ‘record breakers’ in the world!

Here you will find some of the more bizarre and
unconventional recordbreaking feats such as worm-charming;
the fastest pantomime horse, watermelon seed spitting and
the world’s largest collection of bananas...

The UK version of Record Breakers is hosted by internationally-
renowned athlete Linford Christie, but all the items in these
compilations have been specially re-versioned for international
markets.

28 x 1-5 minutes

RIDICULOUS RECORDS – PACKAGE 01
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Genres

NARRATED CHILDREN’S LIGHT ENTERTAINMENT

39 x 1-5 minutes Taken from the BBC series Record Breakers,

Ridiculous Records has the biggest, strongest,
fastest, craziest ‘record breakers’ in the world!

Here you will find some of the more bizarre and
unconventional recordbreaking feats such as worm-charming;
the fastest pantomime horse, watermelon seed spitting and
the world’s largest collection of bananas... 

The UK version of Record Breakers is hosted by internationally-
renowned athlete Linford Christie, but all the items in these
compilations have been specially re-versioned for international
markets.

Including...

Canoe Drop > Charlotte Church > Football
Records > Biggest Dance > Biggest Mexican Wave
> Biggest Cake > Musical Chairs > Paris Roller
Blade Marathon > UK Fire-Walking Record >
Superstar Event > Gnomes in French Park > Sugar
Packet Collection > 24-Hour Mountain Bike
Endurance >World Porridge-Making Championship
> 2000-Hour Blackpool Roller Coaster Record
>World Pea-Shooting Championships > Terry Grant
Hot Dog Record in a Car > Tigers Motor Cycle
Display Team > Gary Rothwell 13 Passenger
Wheelie

RIDICULOUS RECORDS – PACKAGE 02



59

Genres

NARRATED CHILDREN’S LIGHT ENTERTAINMENT

Including...

Baked Beans, Make a Wish > Birdman of
Eastbourne > Basketball > FC Barcelona > Head
Spin, London > Juggler, USA > Plane Pull > Roller
Coaster, Barcelona > Percussion Shoot, London >
Collection Prog I: Noddy, Lowest Car > Collection
Prog 2: Milk Bottle, San Francisco Bridge >
Collection Prog 3; Elvis, Piano > Collection Prog 4:
Rice-Eating, Pez, Ladder > Alcatraz, USA >
Collection Prog 8: Star Wars, Table Footie,Windy
Street > Team Extreme, Alton Towers > Dog
Agility, Ipswich > RAF Falcons,York > Blind
Landspeed, York

Taken from the BBC series Record Breakers,

Ridiculous Records has the biggest, strongest,
fastest, craziest ‘record breakers’ in the world!

Here you will find some of the more bizarre and
unconventional recordbreaking feats such as worm-charming;
the fastest pantomime horse, watermelon seed spitting and
the world’s largest collection of bananas...

The UK version of Record Breakers is hosted by internationally-
renowned athlete Linford Christie, but all the items in these
compilations have been specially re-versioned for international
markets.

27 x 1-4 minutes

RIDICULOUS RECORDS – PACKAGE 03
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Genres

NARRATED CHILDREN’S HISTORY & CULTURE

13 x 5 minutes Royal Portraits introduces the British Royal family,
from Queen Victoria and her great great
granddaughter, Queen Elizabeth II, to Princess
Diana and her son William, the future King of
Great Britain.

Offering a fascinating insight into their lives, Royal Portraits looks
at the glittering pageantry, the personal moments and the role
each has played in shaping today’s House of Windsor. 
Locating each character in the royal family tree, Royal Portraits
uses archive footage to provide concise, visually entertaining
and informative royal profiles.This series of thirteen
mini-biographies combines popular audience appeal with a
high degree of scheduling flexibility.

Including...

Queen Victoria > Edward VII > George V >
QueenMary > Edward VIII > George VI > Queen
Elizabeth,the Queen Mother > Elizabeth II > Prince
Philip >Princess Margaret > Prince Charles >
Diana, Princess of Wales > Prince William

ROYAL PORTRAITS
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Genres

NARRATED LIFESTYLE LIGHT ENTERTAINMENT SCIENCE & TECHNOLOGY

Running order...

Health Food > Performance Food > Food For
Pleasure > Sensing Food > Food Habits > Danger
Food > Food Extremes > Food And Fertility >
Social Foods > Preparing Food > A World Of Food
> Ritual Food

Can eating the right foods improve your brain
power? What about your chances of getting
pregnant? Can you eat yourself to a longer life and
could your culture improve your chances?

We all need to eat, but there’s more to food than mere
survival. Food profoundly affects our bodies and minds, and
can shape whole societies and cultures. Science of Food takes a
light-hearted look at the science and psychology of food,
looking at different cultures to see how they compare, and
examining how food affects the natural world.

12 x 5 minutes

SCIENCE OF FOOD
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Genres

MUSIC BASED HISTORY & CULTURE

25 x 2-4 minutes Explore eight of the world’s most beautiful cities
in this inspiring series of short films, skilfully
edited to evocative music and shot on High
Definition video.

From New York’s skylines to Venice’s waterways, unique and
colourful aspects of each visitor’s paradise are reflected in the
24 charming individual sequences and carefully selected
compositions.

Running order...

New York Architecture > Venice Carnival > Venice
Gondola > Venice Romance > Venice
Craftsmanship > Barcelona Architecture >
Barcelona Gaudi > Barcelona Skyscape > Barcelona
Cathedral > Singapore Dance > Singapore
Splendour > Singapore Traditional > Singapore Art
> Hong Kong Performance > Hong Kong Market >
Hong Kong Mountain > Hong Kong Traditional >
Delhi Journey > Delhi Architecture > Jaipur
Architecture > Jaipur Mountain > Agra Taj Mahal >
Agra Traditional

SITES AND SOUNDS
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Genres

NARRATED LIGHT ENTERTAINMENT

Thirty minutes of the strangest and funniest
events ever to happen within a sporting arena
across a range of sports. 

The Sport Archive is full of truly heroic performances, Gold
Medal winners, World Champions and Record Breakers.
However, things don’t always go to plan and every great
athlete has one performance they’d like to forget. This
compilation is the best and funniest of these moments across a
range of sports.

approx. 30 minutes

SPORTING BLOOPERS
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Genres

NARRATED CHILDREN’S WILDLIFE & NATURAL HISTORY

12 x 5 minutes The secret biological and chemical weapons
of nature!

Stingers reveals the bizarre arsenals of some of the most
poisonous natural defences on earth... and it’s not just the tiny,
apparently weak or creepy creatures that have found ways to
feed and protect themselves by killing or disabling with
venom...

Running Order...

Eight-Legged Monsters > Deadly Dancers > Flying
Killers > Cunning Charm > The Serpent’s Kiss >
Alien Assault > Pirates and Puffer Fish > Slimy
Stingers > Harpoon Hunters > Fiery Dragons >
Rainbow Warriors > Poisonous Growths

STINGERS
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Genres

NARRATED CHILDREN’S LIGHT ENTERTAINMENT

Watch out, watch out there’s a camera about! 
But beware – it could be a Stitch Up!

All children love practical jokes and watching people on screen
being fooled or surprised – especially if the viewer knows
what’s coming and the victim is completely unaware.

Stitch Up! is a hidden camera show with a difference
designed specifically for, and featuring, children. It’s a
non-aggressive, non-humiliation show, but still brim-full of
pranks and practical jokes.

The best tried and tested styles of hidden camera set-ups are
blended together in this unique format, combining ‘quick hit’
visual gags, eccentric characters, a remote-controlled stooge
‘kid’, infiltrated surveillance scenarios and, of course, the
inevitable big ‘Stitch Ups’.

Series I – 13 x 25 minutes
Series 2 – 15 x 25 minutes

STITCH UP!
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Genres

NARRATED HISTORY & CULTURE LIFESTYLE

12 x 5 minutes The ultimate fashion guide for the 21st century!

Modern clothes and body adornments both have either
cultural or spiritual links to our past. Tattooing, body art,
clothing and piercing have all witnessed a surge in popularity in
modern times.

Using stunning material from the BBC’s archive, Style Trek
explores the origins of international style and fashion.

Running order...

Dress to Impress > Body Art > Holding it Together
> Suits You, Sir > Skin Deep > Followers of
Fashion > To Top it off > Animal Attire > Rings and
Things > Stepping out > A Head of Fashion >
Material World

STYLE TREK
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Genres

NARRATED HISTORY & CULTURE LIFESTYLE 

Running order...

It’s a Natural > A Good Cuppa Tea > Wakey Wakey
> Mad Dogs and Englishmen > A Nice Hot Cup of
Tea > Tea and Sympathy > Tea for Two > Is there
Honey still for Tea? > The Tea Chest > Tea Vicar >
Mad Hatter’s Tea Party > Reading the Leaves > The
World’s Favourite Beverage

A refreshing new series...

This new series of short programmes reveals how the humble
“cuppa” has a historical and cultural importance in many
countries and societies around the world.

The series looks at the traditions, the mystique and the cliches
that have built up around this exotic leaf. Using a combination
of archive footage, animation and adverts, this entertaining
series is both quirky and informative.

13 x 5 minutes

TEA BREAKS
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Genres

NARRATED SCIENCE & TECHNOLOGY

20 x 60 minutes Visions of the future...

Advances in knowledge are fundamental to man’s
improvement. From the internet to the great leaps made in
the treatment and prevention of disease, our lives have
seemingly been made better. Informative and entertaining,
these programmes lift the lid on the world of science and
technology that are forever striving to enrich and enhance our
lives. The ground-breaking, the amazing and the outlandish all
feature in these shows which provide comprehensive
coverage of all the updates and latest news from many areas
including science, medicine, leisure and technology.

Running order... 

Laser Fly > Robot Sumo Wrestling > Laser Heart
Surgery > Intelligent Truck > Umbilical Cord Blood
Bank > Concept Car > Electronic Implant > Thrust
Li > Seeing For The Blind > Police Marksmen

TOMORROW’S WORLD
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Genres

MUSIC BASED WILDLIFE & NATURAL HISTORY

Running order...

Penguins > Forest > Coral Reef > Whales > Seals
> Molluscs > Tides > Turtles > Rays > Shoal >
Seahorses > Dolphins > Ice > Sharks > Wrecks >
Jellyfish > Fishing > Birds > Symbionts > Otters

Ultramarine is guaranteed to be the ultimate
experience in underwater viewing.

70% of the earth is covered by oceans and seas, all
harbouring a rich variety of life. From stunning swimmers to
aquatic predators Ultramarine will take you on a journey into
these incredible worlds of beauty, endurance and survival.

Ultramarine features the very best BBC Natural History
footage, artistically edited to composed music, with simple but
informative captions which add to this breathtaking mini-series.
An international version is available.

20 x 3 minutes

ULTRAMARINE
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Genres

MUSIC BASED CHILDREN’S LIFESTYLE LIGHT ENTERTAINMENT

12 x 5 minutes Against the backdrop of London’s gritty, urban
landscape watch 13 of the world’s top football and
basketball freestylers perform amazing tricks.

The freestylers play to the crowds and use whatever they can
find around London to help maximise their skills. A hip-hop
soundtrack adds to the ‘in your face’ nature of this footage
which needs to be seen to be believed.

Running order...

Joe Davis > Tommy Baker > Gerbeshi > Paul
Wood > Rob Walters > Abbas Farid > Billy
Wingrove > Dan Magness > Mike Delaney > Al
Johnson > Craig Dobson > Scott Griffiths > Billy
Fincham

URBAN FREESTYLER
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Genres

MUSIC BASED CHILDREN’S LIFESTYLE LIGHT ENTERTAINMENT

Running order...

Free Running > Basketball > Golf > BMX >
Football > Free Climbing > Mountain Biking >
Trials > Break Dancing > Tennis > Mountain
Boarding > Aggressive Inline

This 12-part series showcases a number of
different sports in urban inner cities, each one
taken to the extreme.

The series features no less than 14 current or former UK
and World Champions. A hip-hop soundtrack adds to the in
your face nature of this footage which needs to be seen to
be believed. 

12 x 5 minutes

URBAN FREESTYLER EXTREME
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Genres

NARRATED CHILDREN’S LIFESTYLE LIGHT ENTERTAINMENT SCIENCE & TECHNOLOGY

12 x 5 minutes Strange things happen to us all the time, and they
are a major challenge to conventional science.

This series takes a sideways look at the experiments designed
to explain the weird science behind everyday phenomena.

Running order...

Gorillas in Our Midst? > Which Way Down the
Plughole? > All Spun Out > The Rain Relay >
Learning to See > Jam Side Down > Under the
Influence > Fan-tastic > The Soundtrack to Our
Dreams > Shower Curtains > Gridlock > The
Power of the Face

WEIRD SCIENCE
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Genres

NARRATED CHILDREN’S SCIENCE & TECHNOLOGY WILDLIFE & NATURAL HISTORY

Examples...

Technology > Geology > Ethnology > Medicine >
Veterinary Medicine > Conservation > Animal
Behaviour > Zoology, Ecology, Biology >
Astronomy > Paleontology > Gadgets inspired by,
or in some way connected with, nature > And many
more...

A magazine-style mini-series featuring innovations,
new research, and original ideas in the fields of
natural science, technology and health.

Entertaining, stimulating and sometimes quirky, these
fascinating magazine items have an enquiring editorial style
focusing on completely new thinking and groundbreaking ideas
throughout the amazing world of the natural sciences.

Unusual, stimulating and visual, Wild Ideas has been designed
for presenterfree, narrated delivery, from the outset.The
International Wild Ideas ‘kit’ supplied will give subscribers the
option to tailor items, by inserting their own local voice or
presenter, and to fit local and channel identities.

12 x 2-6 minutes

WILD IDEAS
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Genres

MUSIC BASED LIGHT ENTERTAINMENT WILDLIFE & NATURAL HISTORY

15 x 3-4 minutes Choosing a prime partner is the best chance any
animal will get to ensure its offspring’s survival.

When it comes to finding the perfect mate, females are fussy.
Only the most eye-catching plumage, the most seductive love
songs, the most splendid dancers, the strongest fighters and
the most caring fathers will do! 

This series combines popular love songs, text and graphics to
explain certain types of animal and human courtship behaviour.

Running order...

In the Mood for Love > Fighting for Attention >
Dressing for Success > Male Posers > Anyone Care
to Dance? > Tokens of Love > Father Figures > Till
Death Us Do Part > Two Timers > Fatal Attraction
> Playing Cupid > The Perfect Perfume > Body
Language > Role Reversals > Long Distance Lovers

WILD ROMANCE
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Genres

NARRATED WILDLIFE & NATURAL HISTORY

Running order...

Islands of the South > Atlantic > Madagascar: Lost
in Time > A Scottish Summer > New Guinea – an
Island Apart > The Great African Rift > The
American Deserts > Canada – Rivers of Life >
Lakes of Fire – Africa’s Rift Valley > The Everglades
> The Badlands > The Arctic > The Amazing
Amazon > Red Sea Reefs > The Australian Strangler
> The Okavango Delta > Palau’s Lost Lake >
Hawaii – Islands of Change > The Caribbean > The
Sahara Desert > Europe’s Alps

Man has always been fascinated by places in the
world that have been untouched by humans.

With the number of wild places around the world diminishing,
this series celebrates those areas where plant and animal life
has retained its pristine beauty and savage nature. 

Wild Worlds is a journey around the planet that reveals the
breathtaking beauty and unclaimed life of the last outposts of
the natural world.

20 x 5 minutes

WILD WORLDS
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Genres

NARRATED CHILDREN’S WILDLIFE & NATURAL HISTORY

50 x 2-6 minutes These two series of Wildvision feature a stunning
collection of short wildlife films.

Each programme portrays the unique lifestyle of some of the
world’s most fascinating wildlife, spectacularly captured on film
by the unparalleled skill of BBC TV’s Natural History Unit.

Rather than attempting a complete biography of the animals in
question, Wildvision instead focuses on a particular or typical
form of behaviour using the short format to perfection.

Examples...

Lion > Killer Whale > Honey Bee > Elephant Seal
> Meerkat > Grizzly Bear > Giant Octopus >
Vampire Bat > Roadrunner > Sea Otter > Shark >
Penguin > Army Ants > Cheetah Cubs > Alligator
> Barn Owl

WILDVISION
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Genres

NARRATED CHILDREN’S HISTORY & CULTURE

Examples...

The Day the Earth Shook > The Four-Minute Mile
> Belsen – The Horror Camp > The Light of a
Thousand Suns > Dawn of the Internet > Uniting
the Nations > The Wall Street Crash > Holocaust
at Auschwitz > Birth of the Pill > The Death of
James Dean > The Fall of Saigon > The Killing Fields
of Cambodia > The Railway of Death > Football –
The First World Cup > My Friend, Evita > Death on
the Mountain > The Face of Evil > The Wall > Man
on the Moon > Tiananmen Square > Dividing the
Nations > Earthquake at Assisi > John, Paul, George
and Ringo > Death of the Mahatma > The People’s
Princess > In The Shadow of the Moon

Man continues to look to climb the highest
mountain and travel further than ever before.
This last century has seen man achieve some of
its greatest dreams, and realise some of its
worst fears.

Man’s first steps on the moon. The atomic bombs at
Hiroshima and Nagasaki. The birth of the Beatles. Just a few of
the key moments from this century.

Each film is based on the first-hand account of a person who
was present at a critical moment of history. Their vivid
memories bring the past to life, and their present-day lives
exemplify the impact of the events they witnessed.

26 x 5 minutes

THE WITNESS
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Genres

NARRATED CHILDREN’S WILDLIFE & NATURAL HISTORY

12 x 5 minutes A Wizard’s Guide to Wildlife is a magical mystery
tour certain to charm an audience of 8-year-olds
and upwards.

The BBC Natural History Unit sprinkles its own magic dust on
the animal allies of Wizards and Witches with a tempting
potion of creepy fantasy and awesome facts. What is the truth
behind their beastly reputations?

Running order...

Hell Hounds > Run Rabbit Run > Night Owl >
Nine Double Lives > Dark Horses > Web of
Mystery > Dirty Rats > Enter the Dragon >
Bewitching Bugs > Charming Snakes > Bat out of
Hell > Toad Skin Spell

A WIZARD’S GUIDE TO WILDLIFE
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Genres

NARRATED LIFESTYLE

Examples...

Shutters > Dressing Table > Lighting >Wardrobe >
Mirror > Floating Shelves > Perspex Screens > CD
storage > Fire Surround > Wine Rack > Archway
Moulding > Bannister Spindles > Radiator Cover >
Coffee Table > Decking > Fabric Door Panels >
Toybox > Lightbox > Mosaic Mirror > Breakfast
Bar > Partition Wall > Bean Bags

If only there was an easy visual guide that could
show you how to transform a tired-looking
bedroom, change out-dated kitchen cupboards,
transform an ugly old fireplace or improve a
stained coffee table.

Well, help is at hand! Using sixty-second ‘bites’, Workshop
Wonders demonstrates how to dramatically improve an aspect
of a typical room using straightforward and simple methods.
Workshop Wonders also brings you building trade ‘inside’
information in a ‘step-by-step’ visual format that’s very easy
to follow. 

Workshop Wonders items are supremely flexible, they can be
used singly to illustrate the way one individual object can be
improved, or using the included graphical stings, the items can
be joined together.

240 x 60 seconds

WORKSHOP WONDERS
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Genres

NARRATED CHILDREN’S HISTORY & CULTURE LIFESTYLE WILDLIFE & NATURAL HISTORY

Long and short form versions are
available.
Long versions are approx 40 minutes.
Short versions are approx 3 to 5
minutes.

Note: Not all episodes have long versions.

Further details of the breakdown are
available upon request.

Where do you go to experience the very best that
the world has to offer?

Where do you find its most impressive wildlife, its greatest
cultures and civilisations? Whether you want to savour the
thrill from the comfort of your home or take a trip to sample it
for yourself, World’s Best will tell you about the best and most
exciting features of our planet and how and where to find them.

World’s Best – perfect for today’s environmentally aware
audience of thrill seekers.

Examples...

Amazing Swarms > Ancient Cultures > Ancient
Sites > Bizarre Creatures > Bugs > Dangerous
Animals > Sea Creatures > Magnificent Beasts >
Nature’s Fury > Natural Wonders

WORLD’S BEST: SERIES 01
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Genres

NARRATED CHILDREN’S HISTORY & CULTURE LIFESTYLE WILDLIFE & NATURAL HISTORY

Examples...

All American Animals > Amazing Animal Builders >
Cool Creatures > Hot Creatures > Sexy Beasts >
Smartest Animals > Ultimate Predators > Wild
Africa > Wild Cats > Wildlife Parks

Where do you go to experience the very best that
the world has to offer?

Where do you find its most impressive wildlife, its greatest
cultures and civilisations? Whether you want to savour the
thrill from the comfort of your home or take a trip to sample it
for yourself, World’s Best will tell you about the best and most
exciting features of our planet and how and where to find them. 

World’s Best – perfect for today’s environmentally aware
audience of thrill seekers.

Long and short form versions are
available.
Long versions are approx 40 minutes.
Short versions are approx 3 to 5
minutes.

Note: Not all episodes have long versions.

Further details of the breakdown are
available upon request.

WORLD’S BEST: SERIES 02
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Genres

NARRATED CHILDREN’S HISTORY & CULTURE LIFESTYLE WILDLIFE & NATURAL HISTORY

Long and short form versions are
available.
Long versions are approx 40 minutes.
Short versions are approx 3 to 5
minutes.

Note: Not all episodes have long versions.

Further details of the breakdown are
available upon request.

Where do you go to experience the very best that
the world has to offer?

Where do you find its most impressive wildlife, its greatest
cultures and civilisations? Whether you want to savour the
thrill from the comfort of your home or take a trip to sample it
for yourself, World’s Best will tell you about the best and most
exciting features of our planet and how and where to find them.

World’s Best – perfect for today’s environmentally aware
audience of thrill seekers.

Examples...

Animal Babies > Animal Battles > Big Bites > Living
Dinosaurs > South America

WORLD’S BEST: SERIES 03
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Genres

NARRATED HISTORY & CULTURE LIFESTYLE

Sample Episodes:

Qasr al-Hajj Berber granary (Libya) > Queen
Nefertari's tomb (Egypt) > Grand Canal of Venice
(Italy) > Chartres Cathedral (France) > Djenne
Mosque (Mali) > Dogon masks (Mali) > Hagia
Sophia (Turkey) > Janter Mantar observatory (India)
> Roman city of Leptis Magna (Libya) > Medici
Chapel (Italy) > Nazca Lines (Peru) > Pantheon
(Italy) > Parthenon (Greece) > Great Temple of
Petra (Jordan) > Wieliczka salt mine chamber
carvings (Poland) > Pyramids (Egypt) > Samarkand
(Uzbekistan) > Teracotta army (China) > St
Petersburg (Russia) > Death mask of Tutankhamen
(Egypt) > Machu Pichu (Peru) > Burial treasures of
the Moche (Peru) > Mud city of Chan Chan (Peru)
> Umaharra headress (Brazil) > Ruins of Palenque
(Mexico) > Toltec giants of Tula (Mexico) > Cliff
palace of Mesa Verde (United States of America) >
Statue of Liberty (United States of America) >
Borobudur Buddhist Temple (Java) > Angkor Wat
(Cambodia) > Taj Mahal (India) > Temple of the
Tooth (Sri Lanka) > Trading domes of Bukhara
(Uzbekhistan) > Meenakshi Temple of Madurai
(India) > Sigiriya rock Palace (Sri Lanka) > Persian
city of Persepolis (Iran) > The Great Wall (China)

The World is full of man-made Wonders – cities,
buildings, edifices, monuments, religious sites,
artworks and even jewellery.

Few of us can expect to know or see them all, but in this travel
and adventure series of forty episodes, each 3 minutes in
length, we bring you an amazing selection of ‘wonders’ to
marvel at. 

Some may be expected, others completely unknown, but
World’s Wonders provides new insights and a great source of
ideas for anyone interested in finding out more about the
world around them.

Duration: 40 x 3 minute

WORLD’S WONDERS
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Genres

NARRATED LIFESTYLE LIGHT ENTERTAINMENT

12 x 5 minutes Are Leos brave or Pisceans dreamers? Our short
programme series Zodiac reveals all!

This twelve part series focuses on Western horoscope signs.
Each programme explores the personality traits, the astrology
and the history behind each star sign.

Running order...

Aries > Taurus > Gemini > Cancer > Leo > Virgo
> Libra > Scorpio > Sagittarius > Capricorn >
Aquarius > Pisces

ZODIAC
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Genres

NARRATED CHILDREN’S SCIENCE & TECHNOLOGY WILDLIFE & NATURAL HISTORY

Running order...

Consuming Passions > Natural Signals > Tiny
Armies > The Mating Game > Alien Architects >
Flying Machines > Amazing Armour > Water World
> Making Tracks > Bug’s Eye View > Extreme
Conditions > Little Rotters

An exploration of the mysterious miniature world
that surrounds us.

This series views the millions of tiny creatures that help make
the world go round, with some even invisible to the human
eye! Zoom uses remarkable micro and macro photography to
open up the strange worlds of some of the smallest and
perhaps most bizarre members of the animal kingdom.

12 x 5 minutes

ZOOM
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Genres

NARRATED WILDLIFE & NATURAL HISTORY

12 x 5 minutes The ultimate guide to animal phobias and their
victims!

Phobias can turn animals into monsters. Fear of animals is one
of our most basic emotions, a natural defence mechanism
against danger. But these fears can escalate into Zoophobia – a
terror that lurks deep inside the human psyche. 

Zoophobia is a series of twelve mini horror films. It explores
all facets of our extreme fear of animals. It unravels fact and
fantasy behind such fears – some animals are truly dangerous,
others merely look threatening, and many are feared
unnecessarily.

Running order...

Arachnophobia: Spiders > Ophidiophobia: Snakes >
Vuktephobia: Bats > Galeophobia: Sharks >
Murophobia: Rats and Mice > Ornithophobia: Birds
> Batrachophobia: Frogs and Toads > Ailurophobia:
Cats > Cynophobia: Dogs > Entomophobia: Insects
> Hippophobia: Horses > Ichthyphobia: Fish

ZOOPHOBIA
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